Extended Shipment Entry SmartFinder — Shipments

Extended Shipment Entry

Extended Shipment Entry is an enhanced replacement for the Sage Shipment Entry screen. It provides
you with more functionality for shipping orders, and fast access to order, customer, and item information.
The following screens show some of the visible features provided by Extended Shipment Entry screen:
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Click the following links for details on each Extended Shipment Entry feature:

SmartFinder — Shipments Find shipments quickly for a customer from a name, number or address.
SmartFinder — Customers Find a customer quickly from a name, phone number or address.
SmartFinder — Orders Find an order quickly from a name, phone number or address.
Item Finder (SmartFinder — Items) Find an item quickly from partial words. Show additional item
columns such as price, quantity and comments. Search also by manufacturer’s item number with the
Enterprise version of Productivity Tools.
SmartFinders provide fast, browser-like search capabilities for looking up data on the Shipment
Entry screen. They search more fields than the Finder and search in all text fields at once. For
example, search for “Seattle” if you think that the customer or contact is in Seattle.

Customer Inquiry (button left of the Customer Name field) provides complete customer data, including

receipts, refunds, order, invoices, IC contract pricing, ship-to addresses, etc.

Calculate Expected Ship Date Use the Business Days and Non-Business Days optional field in the
Productivity Tools Options program to calculate expected ship dates in Extended Shipment Entry.
Customer Optional Fields Display customer optional fields on the Extended Shipment Entry screen.
Require PO Number Optionally require PO numbers on shipments for all or selected customers.
Warn for Duplicate PO Numbers on Shipments Optionally warn users during shipment entry if a
customer purchase order has been used on a previous order or shipment.

Margin and Recent Cost Columns Add 4 margin and markup columns to the item display grid. Click
on a button to display margin and markup for the whole order.

Ship by Picking Sequence and Filter Items Enter quantities picked for a large number of items by
sorting items in picking sequence and restricting the item range — for example, by ship-via code.
Item Quantities Display quantities available at other locations or companies while entering an order.
Quick Forms Printing (O/E Forms) Print an order confirmation, picking slip, or invoice order — or email
a packing slip — without posting the shipment or navigating to another window.

Print Picking Slips Fast Streamline the printing of picking slips, in situations where large numbers of
these are to be printed as quickly as possible.

Prepayments lets you view order prepayments entered in Order Entry, Shipment Entry, or in
Accounts Receivable.

Quick PJC Entry Default newly inserted lines to have the same Contract, Project and Category
selections as the previously entered line.
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Extended Shipment Entry

SmartFinder — Shipments

SmartFinder — Shipments

Click the Shipment Number button to open the SmartFinder for searching shipments. |Shipment Number

Search:

e Enter one or more words or word fragments in the entry field to search multiple tables and fields.

e You can include completed shipments.

e Search displays shipments that contain the search string in any of the searched fields — for
example, one record may have “Royal” in the name, where another may have it in the address

field. Both will be displayed.

o Using multiple words in the search? Enter "300 Main" and the search will find entries "300

Main Street" as well as "123 Main Street, Suite 300".

o Searching for a phone number? Enter the phone number segments separated by blanks.
Enter "451 8991" and the search will find "(451) 555-8991" as well as "(408) 451-8991".

Note:

o All of the word fragments must be present in one of the fields being searched. (For example,
if you searched for “Ross Blvd”, you will not see a shipment where “Ross” is in the Customer

Name field and “Blvd” is in the Address 1 field.)

o Addresses (e.g. the customer address) are treated as a single field.

Display:

e The top grid displays the shipments matching the search criteria. Double-click to select a

shipment.

o The bottom grid displays the details of the shipment highlighted in the top grid.

e Click the Bill-To Address Line 1 column heading or double-click the address to launch Google
Maps with the bill-to address. You can also check the location of Ship-To addresses.

¢ Double-click email addresses (such as the Bill-To E-mail) to create new emails.
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Extended Shipment Entry SmartFinder — Customers

SmartFinder — Customers

Click the Customer Number button to open the SmartFinder for searching customers.

Search:
e Enter one or more words or word fragments in the entry field to search multiple tables and fields.
e You can also filter for Active Customers only.

e Search displays customers and ship-to location records which contain the search string in any of
the searched fields — for example, one record may have “Royal” in the name, where another may
have it in the address field. Both records will be displayed.

o Using multiple words in the search? Enter "300 Main" and the search will find entries "300
Main Street" as well as "123 Main Street, Suite 300".

o Searching for a phone number? Enter the phone number segments separated by blanks.
Enter "451 8991" and the search will find "(451) 555-8991" as well as "(408) 451-8991".

Note:

o All of the word fragments must be present in one of the fields being searched. (For example,
if you searched for “Ross Blvd”, you will not see a vendor where “Ross” is in the Customer
Name field and “Blvd” is in the Address Line 1 field.)

o Addresses (e.g. all fields in the customer address) are treated as a single field.

Display:

e The top grid displays the customers matching the search criteria. In the screen below, two
customers matched “oak”: one for “Oakland” and one for “Roanoke”.

e The bottom grid displays the ship-to locations that match the search criteria. Two ship-to locations
contained “oak” in the addresses. Note that the ship-to locations may not be related to the
customer records displayed in the top part of the screen.

e Click the Address 1 column heading or double-click the address to launch Google Maps with the
vendor address. You can also check the locations of Ship-To and Bill-To addresses.

e Double-click email addresses (such as the Contact E-mail) to create new emails.

Selection:
e Double-click a shipment in the top grid to select the shipment.

e Double-click a ship-to address in the bottom grid to add the customer and this ship-to address to
the shipment.

TaiRox Productivity Tools for Sage 300 3
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Extended Shipment Entry SmartFinder — Orders

SmartFinder — Orders

Click the Order Number button to open the SmartFinder for searching orders. | Order Number

e Enter part of a name or address (or order description or reference) and click the Find button.

e Double-click the order to select it and return you to the Order form.

Search:
e Enter one or more words or word fragments in the entry field to search multiple tables and fields.
e You can filter by order type and include completed and on-hold orders.

e Search returns records which contain the search string in any of the searched fields — for
example, one record may have “Royal” in the name, where another may have it in the address
field. Both will be displayed.

o Using multiple words in the search? Enter "300 Main" and the search will find entries "300
Main Street" as well as "123 Main Street, Suite 300".

o Searching for a phone number? Enter the phone number segments separated by blanks.
Enter "451 8991" and the search will find "(451) 555-8991" as well as "(408) 451-8991".

Note:

o All of the word fragments must be present in one of the fields being searched. (For example,
if you searched for “Ross Blvd”, you will not see a PO where “Ross” is in the Vendor Name
field and “Blvd” is in the Address 1 field.)

o Addresses (e.g. the Bill-To addresses) are treated as a single field.

Display:
e The top grid displays the orders matching the search criteria. Double-click to select an order.
e The bottom grid displays the details of the order highlighted in the top grid.

e Click the Bill-To Address column heading or double-click the address to launch Google Maps
with the bill-to address. You can also check the locations of Ship-To addresses.

e Double-click email addresses (such as the Bill-To Contact E-mail) to create new emails.
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Extended Shipment Entry SmartFinder — Items

SmartFinder — Items

Click the Item Finder button under the item grid to open the SmartFinder for items.

The Item Finder provides several item search options and displays search results in a selection grid with
columns such as price, description, quantity available (current and all locations) and comments. Often,
Order Entry users select between similar items based on these columns.

File Help
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[8 em Number | Desciption ice | Gty Avaiable | [B Gty. Available (Al) | Status | Comment 1

e The Item Finder appears with the “Search” selected by default on the Items tab. This is the most
common way to look up items.

o Type a partial item description or item number in the text field, optionally select Active ltems
Only, and press Enter to immediately search for items.

o Alternatively, select a different “Find Items By” choice. For example, you can choose “Show All
Records” and specify a range of item numbers, structure codes, categories, or account sets using
the range fields. You can specify more selection fields using Additional Criteria.

File Help
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tem Range
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{None) -
{None) -
(None) -

[ (Nare) ~]
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| |
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e The above search screen displays two tabs for looking up inventory items — Items and
Manufacturer’s Item Number — which let you search for I/C item numbers or for manufacturer’s
item numbers.

Search for manufacturer’s item numbers is a Productivity Tools Enterprise feature.

The Manufacturer’s Item Number tab will not appear unless you have a license for the Enterprise
version of Productivity Tools.

e If you do not select the SmartFinder “Search” option, you can select up to four item field ranges —
by item number, status, structure code, category code, and account set code.

e The item price is the quantity zero price for that customer.

e The Item Finder also displays all columns that are in the standard Sage Finder. You can choose
which columns appear in the Item Finder by selecting File > Settings from the Item Finder menu.

e Selecting an item inserts a new row into the order entry grid.

TaiRox Productivity Tools for Sage 300 5
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Extended Shipment Entry SmartFinder — Items

Searching for Inventory Control Iltem Numbers on the Items Tab

The Item Finder on the Items tab provides 7 search options:

File Help

ttems | Manufacturer’s lem Number

Find ltems By

Search

i
f

Show All Records
Item Mumber
Description
Structure Code
Category

Account Set Code

[Central warehouse - Seatle |

Search (most common option) — to search for words or word fragments in item text fields (such
as the item number, item description, structure code, category, price list, picking sequence, and
comments). This search works like the Order Number and Customer Number SmartFinders.

Show All Records — to select items from all item records based on ranges of Item Number,
Structure Code, Category, and Account Set Code and on item Status. You can also specify
additional selection criteria using more item fields.

Item Number — to select items using part of the item number. You can refine your selection
based on ranges of Item Number, Structure Code, Category, and Account Set Code, select items
by item status, and specify additional selection criteria using more item fields.

File Help

ttems  Manufacturer’s ltem Number

Find ltems By

[ hem Number

ftem Range

| [stats with [ |
Starts with

Search by Item Number, Description, Structure Code, Category and Account Set Code also let
you specify a search value that the item starts with or contains.

Note that the “Search” choice automatically looks in all fields shown as columns in the grid.

Description — to select items with descriptions that begin with or contain a string of characters.
You can refine your selection based on ranges of Item Number, Structure Code, Category, and
Account Set Code, select items by item status, and specify additional selection criteria to use
more item fields.

Structure Code — to select items with structure codes that begin with or contain a string of
characters. You can refine your selection based on ranges of ltem Number, Structure Code,
Category, and Account Set Code, select items by item status, and specify additional selection
criteria to use more item fields.

Category — to select items in categories that begin with or contain a string of characters. You can
refine your selection based on ranges of Item Number, Structure Code, Category, and Account
Set Code, select items by item status, and specify additional selection criteria to use more item

fields.

Account Set Code — to select items with codes that begin with or contain a string of characters.
You can refine your selection based on ranges of Iltem Number, Structure Code, Category, and
Account Set Code, select items by item status, and specify additional selection criteria to use
more item fields.

More on the “Search” option (most common option):

Select Find Items by Search. (Note that Find Items By defaults to the last choice used.)

Enter one or more words or word fragments in the next field to search multiple item tables and
fields. (Note that the program scans all columns displayed by the Item Finder.)

You can filter for Active items only.

TaiRox Productivity Tools for Sage 300 6
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Extended Shipment Entry SmartFinder — Items

e Search returns items and customer item numbers that contain the search string in any of the
searched fields — for example, one record may have “Desk” in the Description field, where
another may have it in the Comment 1 field. Both items will be displayed.

Note:

o If using the Search option, all of the word fragments must be present in one of the fields that
are displayed on the screen. (For example, if you search for “desk lamp”, you will not see an
item where only “desk” is in the Description field and only “lamp” is in the Comment 1 field.)

Display:

e The top grid displays the items matching the search criteria. The screen below shows “Desk
Lamp” in the description of one item, and “Desk Lamp” in the comments of the second one — so
both appeared.

e The bottom grid displays the customer item numbers for the item selected in the top grid.
@ e - = ]
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e Click the Qty. Available column to see the location details, with the quantities on hand, on
purchase orders and on sales orders. You can drill down further on these quantities.

Selection:
o Double-click an item in the top grid to select it on the shipment.

e Double-click a customer item number to enter the item number and the customer item number
into the shipment form.

Selecting columns to display — and scan —in the Item Finder

Choose File > Settings in the Item Finder window to change column settings.

file]| Help Unfomatted fem Humber JPY rem Number Up
@hs Altemate ftem Set Number Description
Date Last Mairtained Prce
- -/ Accourt Set Code SlEE Qty. Available Do
Settings...  se— Stocking Unit of Measure - Qty. Available (Al)
Unit Weight > Status
=N | ] Commodity Number Comment 1
USA Date Inactive <- None Structure Code
BT Seqmert 1 Category
[ Active ttems Only Segment 2 Stock tem
Segmert 3 Defautt Picking Sequence
Description Seamert 4 Default Price List Code
Segmert 5 Sellable
Fluorescent Desk Lamp Segment & Serial Numbers
A1310/0  Halogen Desk Light Segmert 7 Lot Numbers
Segmert 8
Segment 9
Segmert 10 v
[The masimum number of columns is 50, selected is 15 OK Cancel
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Extended Shipment Entry SmartFinder — Items

e The current columns that are displayed appear in the right-hand column.

¢ Highlight columns that you want to add in the left-hand column and click the Include button.

Note:

e Settings apply to the currently selected tab. For example, if you want to change the columns
on the Manufacturer’s Item Number tab, choose the tab first, and then select File > Settings.

e Only the “Included Fields” are used for searching. For example, if you do not include the
Comments 1 field, the program will not scan the comments. Also note, that fields like the “Price”
will affect performance because the program calculates the price for the current customer in order
to display it in the item results. If search is slow, remove columns that you don’t need.

All of the possible columns are shown below. Note that optional and calculated fields are also available
for inclusion — for example ltem’s Color and Qty. Available for Sale.

Defaults:

Al [ noude> | Up
Atemate ftem Set Mumber Description

Date Last Maintained Price

Account Set Code FEous Gty. Available 2ainr
Stocking Unit of Measure City. Available (All)

Unit Weight Al-> Status

Commodity Number Comment 1

Date Inactive <- None Structure Code

Segment 1 Category

Segment 2 Stock tem

Segment 3 Default Picking Sequence

Segment 4 Default Price List Code

Segment 5 Sellable

Segment & Serial Numbers

Segment 7 Lot Numbers

Segment 8

Segment 5

Segment 10 h

|The maximum number of columns is 50, selected is 15 0K Cancel

Additional Inclusion Options:
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Comment 3 Allow Different Serial Dty Lot iz on 'Warr. When Sold Mumber of Lotz not Generat Frice

Comment 4 Senialz Dptional Fields Serial Murnbers in Use First Gererated Lot Itern Procurement

Allaws ltem inweb Store Deetault Serial W ananty Cod Serial Mask Structure Last Generated Lot Itern Size

Kitting Item ? Default Serial Contract Code Serial Mask Description Sl Prefered Wendor Type Itern Yolume

Optional Fields |= | Serial is on Cont. ‘When Rec Unformatted Serial Mumber Default BOM Number Warranty

Default Kit Mumber b Senal iz onWar. When Soli Serial Mumber Itern's Color Warranty Period

“wheight Unit of Measure Seral is onwar, When Rec| - Auto-gen Serial Mumber Dangerous ltem Oty OnHand

Unformatted Alternate [kem b Lot Murber Mask 3 Mumber of Serials to Genera Extended Warranty Availabh Oty. On Order

Alternate [tem Mumber Mext Lot Mumber . Mumber of Serials not Gener— Item Type Qty. On Sales Order

Alternate Item Description Use Lots Days to Expire First Generated Serial = | Iter Lead Time Oty. On Hand (&)

Costing Method Lats Daps to Expire Last Generated Serial Manufacturer Qty. On Order

Process Command Use Lotz Days on Quarantin Lot Mumbers in Use tanufacturer Mumber L Qty. On Sales Order (A1)
‘wieight Canversion Factar Lats Days on Quarantine Lat Mask Structure Mew ltem |E | Stocking Unit of Measure

Iz Item & BOM Companent Allow Different Lat Qty Lot Mask Description Price Oty Committed H
Serial Mumber Mask Lats Optiohal Fields Unformatted Lot Number Item Procurement Qty. Committed [&l] |=
Mext Serial Mumber Diefault Lot Warranty Code Lot Mumber Item Size Qty. Available for Sale —
Use Serials Days to Expire ™ Default Lot Contract Code ™ Auto-gen Lot Number i Iterm Yolume i Qty. Available for Sale (&)~

Searching for Items on the Manufacturer’s Item Numbers Tab

Note: The Manufacturer’s Item Number tab will not appear unless you have a license for the Enterprise
version of Productivity Tools.

Search for manufacturer’s item numbers is a Productivity Tools Enterprise feature.

]

File Help

ltems =~ Manufacturers ftem Number
Find tems By
Search |v | |

Manufacturer’s ftem Number
Manufacturer's tem Description
Search

[E Manufacturer’s tem Number | Manufacturer's tem Description | [E kem Mumber | Description City. Available
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Extended Shipment Entry SmartFinder — Items

The Manufacturer’s Item Number Finder appears with “Search” selected by default. This is the
most common way to look up items by manufacturer’s item numbers.

o Type a partial item description or item number in the text field, optionally select Active ltems
Only, and press Enter to immediately search for manufacturer’s item numbers.

Alternatively, select “Manufacturer’s Item Number” or “Manufacturer’s Iltem Description” for
searching.

The Item Finder on the Manufacturer’s Item Number tab provides 3 search options:

TaiRox Productivity Tools for Sage 300

Search (most common option) — to search for words or word fragments in manufacturer’s item
text fields (the manufacturer’s item number or the manufacturer’s item description).

This search works like the Order Number and Customer Number SmartFinders.

Manufacturer’s Item Number — to select items using part of the manufacturer’s item number.

File Help

kems Manufacturers ftem Number
Find ftems By

| Manufacturer’s ftem Number ~ | Starts with ~ | |
Starts with
[ Active ttems Only

You can specify that the item number starts with or contains the string that you enter.

Manufacturer’s Item Description — to select items using part of the manufacturer’s item
description. As with the item number, you can specify that the item description starts with or
contains the string that you enter.

Note that the “Search” choice automatically looks in the manufacturer’s item number and the
manufacturer’s item description fields.
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Extended Shipment Entry SmartFinder — Items
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Extended Shipment Entry Customer Inquiry

Customer Inquiry

The Customer Inquiry button displays the TaiRox Productivity Tools Customer Inquiry screen — a
convenient way to view all data related to the customer. Each tab focuses on an aspect of the customer’s
data.

You can also look up details for other customers while you are on this screen.

(Shipment Number | [4 4 |~ NEW = [» M Q4+ invoice Number | |8 * Required

’ T H12[HJ Q + 0_ =] @ |Mr. Ronald Black | Complete Status |Incompla‘te

PTDEMO - Extended Customer Inquiry - O x

File Help A/R Customer Ing.

Customer No. |14 4

¥ bl Q [E Mr. RonNgPBlack Amounts In  Customer Cumency = USD

Documents ] Receipts l Refunds l .F\diustments] F‘egdingl QE Orders ] QE Invoices l OE Sales l IC Contract Pricing l
Profile lﬁddrgss ] TE@-’SaIes] Credit Status ] Comments] Cptional FAds. l §hip-To| Recur. Charges ] Adiv'rt}:,-’Statsl

Short Name BLACK Start Date 01,/01/2005
Group Code RTL Retail Sales Group Last Maintained  03/01/2013
Account Set USA Accounts Receivable, Other Inactive I f

Rate Type SP On Hold

Temitory CA Account Type  Balance Forward Allow Web Stare Shopping
Price List USA Customer Type  Base Allow Partial Shipmerts
FOB Paint Allow Backorder Quantities
Inventory Location 1 Central warehouse - Seattle Print Statements

Ship Via

Payment Code CHECK Check

Check Language ENG Check for Duplicate POs None

Delivery Method Mail

Billing Cycle BILLWK Weeldy Biling Cycle

Interest Profile INTRTL Interest Profile - Retail

Tems Code DUETEL Due by Invoice Date

Retainage Tems
Retainage % 0.00000
Retention Period 0 Days

oo
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Extended Shipment Entry

Calculating Expected Ship Date for Shipments

Calculating Expected Ship Date for Shipments

The Extended Shipment Entry program will automatically calculate the expected ship date on the header
and details of each shipment, based on your company’s regular business days and any additional non-
business days in your calendar — such as statutory holidays and closures for inventory counts.

You set your company’s business days and a table of additional non-business days in the Productivity

Tools Options program.

e Set your company’s regular business days and additional non-business days on the Business
Days tab in the Options program.

Menu  ftem Quantties Order Entry  Purchase Orders

Business Days
[ Sunday Monday Tuesday
Thursday Friday [ Saturday

Non-Business Days Optional Field

The non-business days optional field is a table of upcoming dates when your business will be

closed.

Note: if you update the dates in the non-business days optional field, you must restart the
Extended Shipment Entry program for the new dates to be in effect.

e Set the number of days from the shipment date to the expected ship date on the Order Entry tab
in the Options program. (Productivity Tools uses the same number of business days for orders.)

Wednesday

NONBUSDAYS Q

Show Totals for This Uinit of Measure

[] Ship-To Location Cannat be Blank

[.] Do Mot Allow Ship-To Address to be Change

Order/Shipment Must Have a Purchase Order Number

[+ Subtract Discount from Margin and Markup Caleulations

Menu  ftem Quantities  Business Days Purchase Orders

Customer Optional Field REQGPOMUM ':‘

Leave the Customer Optional Field blank if a Purchase Order Mumber is required for all customers. Select a Yes./No Customer
Optional Field name to contral this option by customer,

Display a waming i a Customer Purchase Order ig used on more than one Order or Shipment

Set Expected Shipment Date To

& Changed
ljl Business Days After Order Date
Set Deliver By Date To Business Days After Order Date
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Extended Shipment Entry Customer Optional Fields

Customer Optional Fields

If you use the Sage 300 Optional Fields module, you can display any optional fields from the A/R
customer record on the right side of the Extended Shipment Entry screen.

SAMLTD - Extended Shipment Entry

File Help  O/EShipment Entry

(S o) 4 4 [FOOOORORNE ——| b b Q + oot [ |G R
5 e Comte St [rrelie |
Entered By |[RDMIN

Shipmert  Customer Taxes Optional Fields Sales Splt  Rates Totals

Order Numbe |:| L} From Muttple Orders ) PO Number
Tempiate Code | ACTIVE { ShipmentDate |12/02/2020 Posting Date 1270272020 Year/Petiod

PON-0005223 Optional Field
202012 || Accounts Receiv.

Note Alow greater vol

Finance

Location ‘1 ‘ ) ‘K‘ﬁﬂllﬁ\warﬁhuu:e'Sealﬂe ‘ Exp. Ship Date [12/02/2020 No. of Shipments 0| Requires Purcha... Yes
G0 L it I:l 1+ B ol Bt T [ Calcuiate Tax [Pl Greet= kavoice
e ‘Order-ﬁ\ack-DecemberZDQH | Reference  |PON-D009223

This lets you view notes concerning the account during data entry, and also view shipment requirements
— in this example, one of the fields is “Require Purchase Order No.”

You specify which optional fields to display on the Extended Shipment Entry screen in the Productivity
Tools Options program.

Require Purchase Order Number on Shipments

Extended Shipment Entry includes an option to require users to include purchase order numbers on
shipments for all or for selected customers. You select this option in the Productivity Tools Options
program.

SAMLTD - Extended Shipment Entry

File Help  O/EShipment Entry

‘Shipment Number | |4 4 |SHOD000000000000000063 [ e L | = * Required
Customer No S| [V Fonald Back | Conplete Staus [neomplte ‘
ErteredBy  [ADMIN

Shipmert  Customer Taxes Opfional Fields  Sales Spli  Raies Tofals

Oderhamter ] [ |q M@ From Mutiple Orders () PO Number
Template Code | ACTIVE { Shipment Date | 12/02/2020 Fosting Date

Location ‘1 ‘ ) ‘K‘ﬁﬂllﬁ\warﬁhuu:e'Sealﬂe ‘ Exp. Ship Date

Optional Field

PON-D009223
Accounts Receiv.

[12/02/2020 Year/Period |2020- 12
Note Alow greater vol

[12/02/2020 ST Ijl Requires Purcha... Yes

Finance

If you use the option to force PO numbers on shipments, but post a shipment that's missing the PO
number, the following message appears.

£ Error @
Emor
Description: Purchase Order Number cannot be blank -

Source: 14:02:01 -

e The program lets you require PO numbers for all customer shipments, or only for customers with
a “Yes” value for a specific optional field. For example, the Shipment Entry screen pictured above
shows an optional field called “Requires Purchase Order No” where the value for the field
determines if the PO number is required.

e If a customer record does not include a value for the Yes/No optional field, the program will not
require a purchase order number when you create a shipment.

TaiRox Productivity Tools for Sage 300 13
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Extended Shipment Entry

Setting Up the Option to Require PO Numbers on Shipments

In the following example, the program uses the Yes/No value in Optional Field “REQPONUM” (with a
description “Requires PO Number on Orders and Shipments”) to determine whether customers require a

PO number.

e You choose the option and the optional field in the Productivity Tools Options program on the

Sage 300 Desktop:

S
Home

¥ TaiRox Productivity Tools
Accounts Payable Tools
Accounts Receivable Tools
General Ledger Tools
Inventery Contrel Tools
Multi-Company Tools
Order Entry Tools

Purchase Order Tools

~

TaiRox Productivity Tools (General Ledger Tools)

Licensed to: Don Thomson, TAIROX SOFTWARE INC

Dealer:
cC

General Ledger Tools  Order Entry Tools  Purchase Order Tools

~ Visual Process Flows Tools Tools

Session Date: 2021-04-12

sage

For Help, press F1

Inventary Control  Accounts Receivable

A/P Transactions

A/R Transactions —_ —_ g g l\")

B/K Reconciliation . = = =
Accounts Payable  Multi-Company Tools License Information Options Convert Contacts

C/P Transactions Tools

Al Tranca, Hianc &

B ]

S Jroommoren

Menu  ftem Quantities Business Da

Order,-"Shipment Must Have a Purchase Order Mumber Customer Optional Field

Leave the Customer Optional Field blank if a Purchase Order Mumber is required for all customers. Select a Yes/MNo Customer
Optional Field name to control this option by customer.

Display a waming if a Customer Purchase Order is used on more than one Order or Shipment

¢ If you use the option to force PO numbers on shipments — and the customer record includes the
control field with a “Yes” value — the following message appears when you try to post a shipment

that’s missing the PO number.

REGPONUM Q

Require Purchase Order Number on Shipments

TaiRox Productivity Tools for Sage 300

e e T L
T — N
N
Shpment  Customer Taxes Optional Fields  Sales Splt Rates  Totals
Order Number |:|Q L] From Muipls Orders IFO Nomber ' |~
o PO Humber on Order Yes
Template Code ~ |ACTIVE " Shipment Dat d [2021-04 | [LESures
e Nk Bt Gt Wk —— T
Location { [Certralwarchor o E| Prefemed Customer Yes
Nots: Alow gr
e = Description: Purchase Order Numbsr canmiot be blank e | e -
Source: 101513 - ] Due Date Grace Period 0o~
< >

In this example, the “Requires PO Number . . .” field also appears at the top of the Optional Field
list on the Shipment Entry screen.

Note that the field appears if:

o It has been added to the Customer record in A/R.
o Itwas added to the set of optional fields that are displayed in Order Entry (using the
Productivity Tools Options program).

14
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Extended Shipment Entry Warn for Duplicate PO Numbers on Shipments

Warn for Duplicate PO Numbers on Shipments

Extended Shipment Entry includes an option to warn users during shipment entry if the customer
purchase order has been used on a previous order or standalone shipment. You select this option in the
Productivity Tools Options program.

If you try to post a shipment where the PO number has been previously used on an order or shipment,
you will see a message similar to the following.

o Message @ o Message @
Message Message
Description: Waming! There already is an Order for Customer Number 1200, -
whose Order Number is ORD000000000081, which has the same Purchase
Order Mumber 1200.

Description: Waming! There already is a Shipment for Customer Number 1200 .
that was not created from an Order, whose Shipment Number is
SHO0000000000000000080, which has the same Purchase Order Number
12005.

Source: 11:16:49 -

Source: 11:18:41-

Prirt Close Prirt Close
Setting Up the Option to Warn for Duplicate PO Numbers on Shipments
e Select the Productivity Tools Options program.
S
Home
 TaiRox Productivity Tools A . o
Accounts Payable Tools TaiRox Productivity Tools (General Ledger Tools)
ScombRe s L IRE Licensed to: Don Thomson, TAIROX SOFTWARE INC
General Ledger Tools Dealer:
Inventory Control Tools o
Multi-Company Teols
Order Entry Tools - - - -
Purchase Order Tools - )
© Visual Process Flons General Ledger Tools ~ Order Entry Tools  Purchase Order Tools InvEnt.?;{)Euntml A((uunfrzilescelvab\e
AP Transactions
A/R Transactions — B - - -
B aton Accounts Payable  Multi-Company Tools License Information Options Convert Contacts
C/P Transactions Tools
G4l Tranea, rtiane Y
Sage  ForHelp, press Fl Session Date: 2021-04-12 A
e Choose Order tab and then choose the option for displaying a warning for dulicate PO numbers.
Menu  ftem Quantities Purchase Orders
[ Order/Shipment Must Have a Purchase Order Mumber Customer Optional Field REQPONUM '1_;
Leave the Customer Optional Field blank if a Purchase Order Mumber is required for all customers. Select a Yes/MNo Customer
Optional Field name to control this option by customer.
Display a waming if a Customer Purchase Order is used on more than one Order or Shipment
Order/Shipment Customer Optional Fields To Display
N Include -> equires PO Number on Orders & 5 Up
Accounts Receivable Contact T Customer Credit Waming
BBF Price Level Prefemed Customer
BBR Price Level SEcnE Note e
TaiRox Productivity Tools for Sage 300 15
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Extended Shipment Entry Margin and Recent Cost Columns

Margin and Recent Cost Columns

Knowing item and order margins is important when margins are constrained contractually or when the
most recent cost may be used rather than a price list. Extended Shipment Entry saves you time by
displaying margin and cost data on the shipment entry screen.

Item margin and cost information in the order grid

Extended Shipment Entry's line detail grid includes 4 additional columns for margins and costs:

Margin Percent

Markup Percent

Margin Amount

Most Recent Unit Cost (based on P/O receipts).

You can also include line discounts in margin and markup calculations by selecting the option to “Subtract
Discount from Margin and Markup Calculations” in the Productivity Tools Options program.

Note: Users must have Order Entry Iltem Cost Inquiry rights in order to see the margin columns.

Order margin information

e Click the Shipment Margin button (below the item quantities) at any time to see the margin on the
shipment as a whole.

[ ltem Finder... ] [ Ship... ]I Shipment Margin... ]

PTDEMO - Extended Shipment Entry

File Help O/E Shipment Entry

[Shpment Number ] 14 4 [SHODI00000000000000045 [P M QU+ inveice Number =

Entered By ADMIN
Shipment  Customer Taxes Optional Fields Sales Split  Rates  Totals
Order Number |OHDDDDDDDDDDM3 ‘ L, From Muttiple Orders 0_ PO Number | |
Template Code  [ACTIVE Shipment Dt [08/10/2020 Posing Date  |05/10/2020 Year/Period
Losation £ | . [Port of Vancouver | Bo.sipDse 571072020 No.of Shipmerts | (]
Ship-To Location 0_ Job Related Project Invoicing Retainage Calculate Tax Create Invoice
Description |0vemight shipment please Reference  |Ref #1005-1-1
Q, Non-Stk. CIr Order No ] Optional Fiel Margin Percent Markup Percent Margin Amourt | Most Recent Unit C.
ORDOODOO000D...  Yes 24 38662 33.13208 35.12 146.682800
ORDOODOO000D...  Yes 0.35346 0.35472 0.94 366.707000 | |
ORDOODOO000D...  Yes 51.0924% 104 46758 186.58 247.154060 |
ORDOODOO000D... Yes 26.55672 36.1594% 56.50 215892173
% PTDEMO - Shipment Margin == | -
] File Help
Cty. on Hand Gty on Sales Order Gty. on Purchas: Margin Percent e
octon 3) = o ek e ‘
302 1 12
Al Locations (E2) | Margin Amourt 138192
Components... ltem Finder... Ship.. Shipment Margin... :I
Post Prepayment [ O/E Forms ] [ Close l
Database 1D Description Description Gyl
PTDEMO Productivity Tool... 1 Central warehou... AZ(IMAGE-1500)G  Image 1500 Seri... Ea. 18 o
PTDEMO Productivity Tool... 2 Portland Office AZ(IMAGE-1500)G  Image 1500 Seri... Ea. 0 -

| r

< | m

TaiRox Productivity Tools for Sage 300 16
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Extended Shipment Entry Shipping Quantities by Picking Sequence and Filtering Items

Shipping Quantities by Picking Sequence and Filtering ltems

The Ship button lets you display items in picking sequence order, item number order, or by location and
filter them by ranges of shipment fields.

For example, the following screens show items ordered by Picking Sequence and selected by Ship-Via
code.

Ship by Picking Sequence functionality is very useful when a large order has been picked and now the
picked items have to be recorded as shipped.

e The picking slip is in picking sequence order with quantities marked.

e The shipment entry form is displayed in line number order.

Matching and recording the entries from the picking slip is far easier when you list the items in
picking sequence order.

Item selection makes it easier to record partially shipped orders — in this case, where all items with the
same Ship-Via code are in one shipment.

= PTORMO - Shin == )

Shorarl Cusiomer Tages Cplooal Feds SabesSpll Bates Tafa

[OROOBR00000075 1

Terpisie Code [FCTVE { SwomeiDue  [FV0ZZ |

b [ | o

SoTolocson [WRES | +

Q em o / Msc Charge

Oty O Sy 0 o T [r— Gy donki
0 0

PIOEND Producay Tod. 1 Cantrl warshou.. 12208 Faga 220 dm .. Ea % 0

To use the Ship button to enter quantities:
e Click the Ship button to display the Ship form.

e Select the primary order for listing items.

% PTDEMO - Ship
File Help
Order By
Select Order By
Picking Ssquence ]
(None]
Picking Ssqusnce

ltem
Location

You can choose by Picking Sequence, Item, or by Location.

e Choose the next sorting levels if you want a multi-level sort — such as by Iltem number and
location.

e Choose a field for selecting a range of items.

Selsct tems By
Ship-Via Code [-]
{None)
Picking Sequence
ltem
Location
Price List
Categor
[ ey
TaiRox Productivity Tools for Sage 300 17
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Extended Shipment Entry Shipping Quantities by Picking Sequence and Filtering Items

You can choose picking sequence, item, location, price list, category, ship-via code, expected
shipment date, date requested, backorder — or shipment details optional fields.

e Click the Load button to display items from the order you selected (in this case, items shipped by
CCT displayed in picking sequence).

(@ samLTD - swip [E=NESR)
Fle Help

Order By

Select Order By

-

Location -

(None) -

Select fems By Gem To
Ship-Via Code - |CCT ‘ -"‘. ‘CCT

(None) -
(Mone} -

Description oCatic Order UOM
Krugg 220 Amn Titer-Brown

7400 Series Posture Chair
Fluorescent Desk Lamp
Halogen Desk Light

e Enter quantities in the Qty. Shipped column.

o You can enter the picked entries quickly using the Tab or Enter keys to move down the

column.
Line Number | Picking Sequence : Description Location | Order UOM | Gty. On Order (Order UOM) | Ctty. Shipped
0010 Krugg 220 Am Titter-Brown Ea.
4 0023 C2-740/Y 7400 Series Posture Chair 1 Ea. 25 0
3 D040 A1-103/0 Fluorescent Desk Lamp 1 Ea. 8 o
2 0041 A1-310/0 Halogen Desk Light 1 Ea. 15| i}

e When you close the Ship form, the Qty. Shipped numbers in the order entry form will be updated
with the item quantities that you entered.

e Click the Ship All button at the bottom of the form to fill in the Qty. Shipped field for all items with
the Qty. On Order.

Qty.OnHand  Qty. On Sales Order  Gty. On Purchase Order Gty. Committed Gty. Available
Location 1(Ea.) Fal 15 [H 0 0 71
All Locations (Ea.) 231 15 [H 4 [H 0 231

I Ship Al I Close

Note:

If you change the quantity shipped for an item with a serial number you may see a pop-up Sage
300 windows like the following, allowing you to pick the serial number from the Finder.

[E] serial Numbers Allocation =]
Item Murrber A1-900/8 Losation 1 Stack Date 07/01/2020
Sl |
[ futollocate From
@ Serial Number B

i 00193 o [l

(| Finder - Inventory Serial Numbers =0 iR )

File Key Settings Global Settings

Find By:  Show allrecords - | FndNow | [ Set Cteria

[¥] Auto Search

April-00138 A1500B 1 Available 7 =
N S N P S 717
. April-00200 A1500B 1 Available 7/1/2020 |
Uriit of Measurs Ea. ] = ] S
Serial Nos. Required
Alocated Help
Remaining
TaiRox Productivity Tools for Sage 300 18
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Extended Shipment Entry

ltem Quantities

Item Quantities

The Item Quantities feature lets you display items quantities available at all inventory locations — including
locations in other companies — while entering a shipment.

To display quantities for multiple locations and companies:

e Select the Extended Shipment Entry > File > Settings menu choice to change the Item

Quantities display settings.

% PTDEMO - Extended Shipment Entry Settings (=l
[~ Post Shipment and Prnt Picking Slip Directly
Picking Sips
Print Destination Desktop Defauit -
Use Sip |0EP\CKSHIPMENT1.HPT \ [ T ]
Sort By Picking Sequence -
[7] Print Serial/Lot Numbers
[] Require Shipping Labels
[T] Print Kit Companent ftems
[] Print Bills Of Material Component tems
[pisoiz tem Quanizes | Display on Ertry Screen [~]
e —
L Displayon Separste Screen
o Do Not Display — shows only total quantities and quantities for the current line item location

— like the standard Shipment Entry screen.

Qiy.onHand  Qly. on Sales Order Qty. on Purchase Order Qty. Committed Qly. Available

Location 4 (Ea) 167 2[5 200 [£ 0 167

Al Locations (Ea.) 731 2[5 800 [5 0 731

Components... ltem Finder. Ship Shipment Margin... Shipment Subtotal ‘ 324 73| |USD ‘
Post Prepayment [ O/E Forms ] [ Close ]

o Display on Entry Screen — includes a grid at the bottom of the screen that displays
guantities at all locations, in the current company and any associated companies.

Qty. on Hand Gty. on Sales Order QGty. on Purchase Order Qty. Committed Qty. Available
Location 1(Ea) 26 10 10 [] 26
All Locations {Ea.) 74 10 [ 10 [4 (] 74
Components. [ Ship Al ] [ ltem Finder. ] [ Ship. ] [ Shipment Margin. ] Shipment Subtotal DD—D| |USD |
Post History. Prepayment. 0O/E Forms

Database ID Description ltern Mumber Description Stocking Unit Qty. On Hand
PTDEMO Productivity Tool... 1 Central warehou. C1-220/B Krugg 220 Am Ea 26 10 —
PTDEMO Productivity Tool... 2 Portland Office C1-220/B Krugg 220 Am Ea 24 0 -

4| 1

| 3

o Display on Separate Screen — displays the item quantities at all locations in a separate

window.

PTDEMO - Item Quantities
File

Help

Database 1D Location ltem Number

Description Stocking Unit

PTDEMO Productivity Toal. 1 Certral warehou...  A1-103/0 Fuarescent Des. Ea 137 160 10 137 ‘E

PTDEMO Productivity Tool 2 Portland Office A1-103/0 FAuorescent Des. Ea 262 0 3 262 |

PTDEMO Productivity Tool 3 Newark, New Je. A1-103/0 Fuorescent Des. Ea 42 126 L] 42

PTDEMO Productivity Tol... 4 Port of Vancouver  A1-103/0 Flucrescent Des. Ea 206 0 1 206 -
m 1 3

Click the All Locations button to move the Quantities in front of other windows (if hidden).

TaiRox Productivity Tools for Sage 300

The All Locations button appears at the bottom of the Extended Shipment Entry screen if you
choose to display quantities on a separate screen.

Item Quantities will be refreshed as you move to other detail lines.
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Extended Shipment Entry Item Quantities

Selecting which companies and locations are displayed

An administrator must first set up the Sage 300 company databases and locations that are displayed in
the ltem Quantities grid.

e Goto TaiRox Productivity Tools > Options, and click the ltem Quantities tab.

PTDEMO - Options

File Help

Menu  ttem Quantities

Database ID | Description User ID Password Location
SAMLTD Sample Company Limited sa pass1234 1
SAMINC Sample Company Inc. =3 pass1234 1

SAMINC Sample Company Inc. sa pass1234 2
SAMLTD Sample Compary Limited =3 pass 1234 2

PTOEMQ |~/ Productivity Tools Demao sa

CHKWAN

CPYINC

CPYLTD

PTCOPY

PTDEMO

o Use the Insert and Delete keys to add or remove locations and companies from the Iltem
Quantities grid and to change the order that locations appear.

Each user can customize the item quantities grid by hiding and moving columns to suit their own needs.

For example:

e You can hide the Database ID and Name columns if all locations are in the same Sage 300
company.

e You can also hide the Item Description and Stocking Unit if these are the same at all locations.
Hide and re-arrange columns by dragging and dropping.

PTDEMO - Item Quantities

File  Help
Location Description ftem Number Gty.On Hand | Gty.On Purchase ... | Gty. On Sales Order Gty. Availzble Gty. Committed | Gty. Available fo... | Gty. On Hand (Al il
Certtral warehou... | A1-103/0 137 0 127 657 £

2 Portland Office A1-103/0 262 ] ] 262 L] 253 657 286 ||
3 Newark, New Je... A1-103/0 42 126 0 42 L] 42 657 286
4 Port of Vancouver  A1-103/0 206 ] L 206 L] 195 657 286 -
< 0 ] v

i
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Extended Shipment Entry Quick Forms Printing (O/E Forms Button)

Quick Forms Printing (O/E Forms Button)

The O/E Forms button lets you quickly print a number of order and shipment-related forms, without
posting a shipment or navigating to another window.

The OE Forms popup also appears automatically when you post shipments, letting you print order
confirmations, picking slips, and invoices — or email packing slips to customers — immediately after
posting shipments.

Note: The form will not appear automatically if you choose “Post Shipment and Print Picking Slip
Directly” from Extended Shipment Entry Settings. (Select File > Settings from the menu.) See the
next section — Print Picking Slips Fast — for details on printing picking slips directly.

SAMLTD - Extended Shipment Entry

File Help O/ Shipment Entry

Shipment Number | [4 4 [SH00000000000000000002 P B Xl +  invoice Number [INODDODO0DO0002 =
R 5 0 B [ Rened Back Complete Status [ompRte |
ErieredBy  |ADMIN

Shipmert  Customer Taxes Optional Fields ~Sales Split  Rates  Totals

Order Mumber | |ORDODO0D00D0004 = From Mutiple Orders [ PO Number | | Optional Field
’ : Prefered Customer Yes
Template Cod ACTIVE Shipmert Dat [2019-0217 Posting Date 20180217 Year/Period |2019-02
RO R Ll saneno Order/Shipment Requires PO Number Yes
Location ‘4 ‘ ‘Fnrt of Vancouver ‘ Bp. Ship Date 20130217 (P e Dl Note Hlow d
— UPS Zone WHI
Fry T et |:| = JobRebated [ | Praject Invoicng e e Create Invoice | Customer Credit Warming No
etet ‘Ship ASAP, backarder OK ‘ Reference  |Ref 0902 ‘ a o
Q tem No./ Misc. Charge Q, Kit/BOM | Desciption Bl Oty. Shipped
1 lem A-103/0 Fluorescent Des...  LUSA 4 10 0 10
2 tem A1-320/0 SOW/12 Halog... USA 1 7 0 7
3 fem A1-310/0 Halogen Desk Li.  LISA 1 3 0 3
4 tem AT400/0 Desk Note Book  UISA 4 30 0 30
5 tem AT-450/0 Bulletin Board UsA 4 15 0 15
v
< >
Gty.onHand  Gty. on Sales Order Gty. on Purchase Order Gty. Committed Gry. Avaiable
Location 4 (Ea) 206 20 4 5[4 0 206
All Locations (Ea.) 650 51 (8 491 [8 0 850
em/Tax. Comgonents. kem Finder. Shp... Shipmert Margin... | Shipment Subtota
Post History... Prepaymert... O/ Foms... Close

To print OE forms
e Click the O/E Forms button.

The following form appears. Click the buttons on the right to use the Sage 300 printing functions
and the Productivity Tools Email Packing Slip function.

Eile Help

Order Number Q Print Order Corfirmation...

Shipment Number |SHCHIH]]]]]’D’IHH]]]]]]}D2 ‘ Q Print Picking Slip..

Invoice Number |INDDﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂ2 ‘ Q Frirt Invaice...

Shipment Number |SHCHIH]]]]]’I]’I]4H]]]]]}D2 ‘ Q Email Packing Slip...
Close

e You must select a shipment number for the Print Picking Slip and Email Packing Slip functions.
By default, the current shipment number will be used unless you change it.
e Selecting the Email Packing Slip choice

Productivity Tools lets you email customers packing slips for each shipment. The following form
appears when you click the Email Packing Slip button.

TaiRox Productivity Tools for Sage 300 21
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Extended Shipment Entry

SAMLTD - Email Packing Slips

Quick Forms Printing (O/E Forms Button)

File  Help
Use Slip |OEPACKSHIPMENT‘I RPT | TR
Sort By | Line Number V|
From Shipment Number |5HDDDDDDDDDDDDDDDDDD35 ‘
To Shipment Number [5HO0000000000000000085
Message 1D |PACK‘NG | 4 0_
[] Print Serial/Lot Numbers
[ Prirt it Component ftems
[ Prirt Bills Of Material Companent tems
Email To Email Address Ertered b
=

T0QIEss

Send

Cloze

Select the Crystal report form for packing slips.
Confirm the shipment number. By default, this is the Last Shipment Number for the order.

o Select the Message for the Packing Slip. You can edit messages using the O/E E-mail
Messages program, or click the Zoom button beside the Message ID field to load the form.

o Select what you want to appear on the packing slip: serial/lot numbers, kit component items,

or BOM component items.

o Specify an email recipient or select the customer or ship-to email addresses for sending
packing slips. The customer and ship-to email addresses come from the A/R customer

account.

If you choose “Email Address Entered”, enter the recipient’'s email address.
You can separate multiple email addresses with a semi-colon, comma, or blank space.

For more information on emailing packing slips, see the Email Packing Slips User Guide.

TaiRox Productivity Tools for Sage 300
© 2009-2024 TaiRox Software Inc. All rights reserved.

22



Extended Shipment Entry Print Picking Slips Fast

Print Picking Slips Fast

Extended Shipment Entry lets you streamline the printing of picking slips when you need to print large
numbers of them as quickly as possible.

Note: The O/E Forms popup will not appear automatically after posting if you choose the “Post
Shipment and Print Picking Slip Directly” option. However, you will still be able to print forms by
clicking the O/E Forms button at the bottom of the screen.

Use the Settings choice on the Extended Shipment Entry File menu to select picking slip default settings,
so you don’t need to answer the setup questions in a pop-up dialog box:

PTDEMO - Extended Shipment Entry % PTDEMO - Extended Shipment Entry Settings (==
LicIDBRO/ESipmenkEntry [ 11 Post Stipment and Print Picking Sip Directly |
Customize.. |4 4 [SHODDDDDDDDDDDDDOC Ficking Slips
Print Destination Desktop Default -
Settings... Uss Slip [EPICKSHIPMENTT RPT Il Browse |
Close Sort By Picking Sequence -
Shipment  Customer Taxes Optional Fields  Sales [] Prirt Serial/Lot Numbers

[~ Require Shipping Labels
[ Print Kit Companent tems
[ Print Bills Of Material Componert tems

Disolav tem Quantites Do Mot Display -

e Select the first checkbox at the top of the form to change picking slip printing behavior.

e Choose the Print Destination for picking slips. These settings bypass the setup and print picking
sequence dialogs.

o Choose the Preview setting to do a final preview before printing

Print Destination Desktop Default -
e Sk Desktop Default
Printer
ot By Preview
TaiRox Productivity Tools for Sage 300 23
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Extended Shipment Entry

View Order and Shipment Prepayments

Although Sage 300 lets you add prepayments on the Order Entry and Shipment Entry screens, it doesn’t
let you view prepayments that have been entered for orders or shipments.

View Order and Shipment Prepayments

The Prepayments button on the right side of the Extended Shipment Entry screen lets you view all
prepayments entered using the Order Entry screen, Shipment Entry screen, or the Accounts Receivable
Receipt Entry screen that apply to the original order to the current shipment.

To view order and shipment prepayments:

e Click the Prepayments button at the bottom of the screen.
Post History. Prepayment O/E Forms Close
Database ID Description tem Number Description Stacking Unit Gty Availafial
SAMINC Sample Compan... 4 Port of San Fan...  A1-103/0 Fuorescent Des... Ea. 206 (1] 10 pt
SAMLTD Sample Compan... 1 Central warehou... A1-103/0 Fuorescent Des... Ea. 144 260 21 v
e The program displays a pop-up form that lists all prepayments for the order or shipment — 1 in the

following example:

2

Payer

Mr_Raonald Black

Paymert Date | Posting Date | Customer Cumency Code

2022-12-06

[ Documert Number

Aoply To

Order No_ [ ORDOODODDO00DES

Payment in Customer Cumency

3.850 45

Prepayments
Customer Number [1200 | [¥r- Ranald Black |
Order Number [DRDD0D000000085 |

Amourt Remaining | [B Batch Number
3.890.45 | 66

[& Entry Mumber

2

Total

Amount Remaining

3.890.45

3.890 45

Close

In this example, the prepayment is for one half of the order amount.
Click the Document Number column heading to drill down to the original document.

Click the Batch Number or Batch Entry column heading to drill down to the receipt entry in
Accounts Receivable.

TaiRox Productivity Tools for Sage 300
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Batch Number 4 4 b QB [Frepayments |
Batch Date 2020-08-30 No. of Entries Total Amount

Bank CCB . Default Cumrency CAD . Depaosit Number . Deposit Date 2020-08-30

Ertry Number 4 P M Q[ | | Entered By
Transaction Type Receipt Date Posting Date ‘2022'12‘06 ‘ |2022 -12 ‘
Ermme i e |1200 | Q] |Mr. Ronald Black ‘ Curency
Reference | ‘ Account Set UsSA
pamtCot =

Document Number |PP‘:M:'':''--''--'‘:M:''--''--'‘:":":"--":M:":"--":'19 | a Job Related
Receipt Amount | 5DDD.DD| |CAD | N Customer Amount | 3.890. 45‘ |USD ‘ Optional Fields 0_
Apply By [Ordler Number | Apply To [oRD000000000085 |




Extended Shipment Entry Quick PJC Entry

Quick PJC Entry

To speed up data entry, Extended Shipment Entry will default inserted lines to the previous entry's
selections for Contract, Project and Category when multiple lines use the same selections.

The following form shows how the shipment form appears immediately after pressing the Insert key to
create the second line (with default values for the Contract, Project, Category and Cost Class fields):

SAMLTD - Extended Shipment Entry

File  Help  O/E Shipment Entry

[Shipment Number] 14 4 |... NEW = | | 3 ] 'Q + Invoice Number | |L, * Required

(e 0 T+ TR s e —
S —

Shipment Customer Taxes Optional Fields Sales Splt  Rates  Totals

Order Number ] | | ‘:\( L, From Multiple Orders PO Number | |

¢ ) i ) a ) Accounts Receiv... Fing
Template Code  [ACTIVE ©  Shipment Date  |12/02/2020 Posting Date 12/02/2020 Year/Period |2020-12
: < s . el e -
Location |1 | 'Q |CentrE|| warehouse - Seattle | Exp. Ship Date 12/02/2020 No. of Shipments ljl Requires Purcha... Yes
Ship-To Location l:l ':\( + D_ Job Related Project Invoicing Retainage Calculate Tax
Description | | Reference | | 4 m »

Q, Misc. Charge

Q, ttem No.

Q, Project Q, Category Cost Class

Q, Contract

ltem 120-1200-10 1009 PRCHDESK Material D2-613/B
| [120120010 PRCHDESK \wateil | [ |\
L
B
< T +
City. on Hand Cty. on Sales Order Cty. on Purchase Order City. Committed City. Available
Location 0 0 0 0 0
All Locations 0 0 0 0 0

Components... ltem Finder... ] [ Ship.... ] [ Shipmert Margin... Shipment Subtotal | ﬂ.DD| |USD |

[ Q/E Forms.. ] [ Close ]

[ Post ] [ History.. ] [ Prepaymert...

Database 1D Name Location Description ltem Number Description Stocking Unit Qty. On Hand | Qty. On Purcha... | Gty. On Sales
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